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1. Overview 

TOPSIM - General Management II is a challenging, computer-based, management game that 
you can install on your personal computer. 
 
The management game includes: 
• The management game’s software consisting of the instructor’s system  (including a 

function to display EXCEL graphics) and the participants’ system 
 
• The manual consisting of the data and information for participants, the instructor’s 

manual, and documents and information for conducting the seminar. 
 
The instructor’s system is the actual management game.  With this software alone you can 
implement the entire management simulation, i.e. enter decisions from participating teams, 
simulate the periods, and issue reports. You can allow the participants to access the planning 
models on their own system. The actual simulation (of the periods) can only take place 
with the instructor’s system. Other functions of the instructor’s system are explained in 
more detail below. 
 
The participants’ system is an additional aid you may employ in the seminar, provided that 
each of the participating groups have a personal computer to work with. If you make this 
software available to the participants, they can then begin to work with the initial situation of 
their companies. They can also visit the company virtually. They complete a virtual tour 
through which they receive the information they need for the simulation. This information is 
identical to the content in the user’s manual. In the process of running the game, you can view 
reports from the last simulated period or print them out, activate the planning model, and 
make decisions with the help of the participants’ system. 
The exchange of data between the instructor’s system and the participants’ system takes 
place: 
• Via the so-called participants’ transfer diskettes (also called "participants’ diskettes"). 

With these diskettes the participants submit their decisions to the instructor, and with the 
same diskettes he/she gives the results (reports) from the previous period back to the 
participants. (diskette version): 

• Or via the network: In this case, data is exchanged directly on the server from directory to 
directory (using the network version). 

• Other storage devices, e.g. USB-Sticks 
 
 

In Version 11.0 there are more ways in which you can transfer data in 
comparison to previous versions. As a result there is also greater possibility for 
error. We recommend that you follow our instructions for transferring data 
closely. 
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Working with only the instructor’s system: 
 

 
With the instructor’s system alone you are able to conduct the entire management 
game. You, the instructor, would enter all of the participants’ decisions on this 
system. The reports for the participants are also produced on this system.  
 
The actual simulation of the results is always carried out on the instructor’s 
system: 

        Participants’ decisions  
        on decision forms 

   � Í ������ 
    Ð    Reports 
 ����� to be distributed to the participants 

 
 
Working with both the instructor’s and the participants’ systems: 
 
 
 
 
 
 

 
Decisions from 
participants’ 
computers to the 
instructor’s computer 

 
 
 
 
 

 

 
Instructor’s System 

� 

 
Transfer diskettes 

����� 
or another medium  

(USB stick, network,…) 
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After the simulation: 
Results from the 
instructor’s computer 
to participants’ 
computers. 
 
 
Participants’ 
Systems 
 
 
 
Participants’ Reports 

 
 
Reading the participant’s manual or visiting the company virtually on the participant’s 
system introduces participants to the initial position of their “company” and the rules of the 
game. The starting situation is the position of the company before the game begins, which is 
at the end of Period 0. The user manual contains different "appendices" at the end that can be 
made available to the users. You can use the appendix with operating instructions for the 
participants’ software if the participants are working on their own computers. 
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The instructor’s manual consists of three main sections: 
 
• Introduction and Installation: This section, which you are reading at the moment, 

provides you with an overview and a general explanation of how to operate the 
management game. 

• Explanatory Notes on the Game: This section serves as a reference, and provides you 
with tips on how to deal with and to interpret the results. 

• Appendices contain files on procedures for the standard game, and further tips that you 
may occasionally need. 

 
Use the documents and information for conducting the seminar during the course of the 
seminar. This includes: 
• Decision forms: These are hard copies of forms. Use them when the participants are not 

working with the participants’ software and must submit their decisions to you on paper. 
The three standard game versions each have a different progression with respect to when 
features are activated. The decision forms contain different groups of decisions for the 
various periods. 

• Scenarios: These are the economic reports with tips for the participants as to which 
economic conditions they must consider when making their decisions. As there are always 
three different game progressions in every game package, this section of the manual 
contains three different texts, each explaining a scenario. These texts are referenced 
clearly in the footnotes so as to avoid confusion. The users also receive the scenario texts 
on the transfer diskettes (see the pocket in the manual labeled “5”, section 3.2.2 called 
"Data for the Periods"). 

• Overhead transparencies: You can use these, if necessary, to introduce the seminar to 
the users. Transparencies for group projects and analysis of the seminar have already 
been prepared and are available for use. 
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2. Hardware and Software Requirements 

A computer that can run Windows 2000 or XP and contains a disk drive or another device that 
has no data saved on it yet (e.g. USB stick) is required. (It is also useful to have a CD-ROM 
Drive for installation). These requirements apply to both the instructor’s, as well as the 
participants’ systems. The disk drive is only necessary if both the installation and data transfer 
will occur via disks.  
 
Required hard drive storage space: On the hard drive you need about 20 MB of storage 
space for the instructor‘s system and about 18 MB for the participants’ system. 
 
The management game can also be installed and run on a network. For more details, see the 
explanations below. 
 
You are advised to have some formatted disks available to create backups, and to use as the 
so-called "Participants’ Transfer Diskettes.” 
 
If participants are working on their own computers and are not connected to a network, you 
will need as many disks as there are groups. 
 
Printer: You may use any printer for which a corresponding Windows printer driver has been 
installed. The time it takes to process the results depends solely on the speed of the printer, 
as the simulation takes just a matter of seconds.  
 
Printer settings: B/W or raster graphics; max. 300 dpi; Portrait. 600dpi requires four times 
more printing time; Print TrueType as graphics.  
 
In order to present the reports in the correct font, the settings 049 for Country-code and 437 
or 850 for Code-page should be made in the Autoexec.bat and Config.sys files. 
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3. Installing the Software 

After inserting the CD or running the file “gm2setup.exe”, the following box will appear so that 
you can start TOPSIM - General Management II. 
 

 
 
It is possible to install the simulation directly from the CD-ROM.  
 
The installation program installs the management game. It suggests a file path name, where 
the software will be installed.  However, this file path name can be modified. 
 
The default file paths are as follows: 
C:\GM2SPL : Instructor’s System 
C:\GM2TLN: Participants’ Systems 
 
The systems for the five groups that are participating are either installed on five separate 
computers or five times on a network. You are advised to add the group number to the file 
names of the participants’ systems. For example: 
 
Group 1: Path  \GM2TLN1  Or on network:  M:\GM2TLN1 
Group 2: Path \GM2TLN2  Or on network:  N:\GM2TLN2 etc. 
 
The number of characters for a file path on a network may not exceed 60.  Please pay 
attention as to which drive is being used to install the files, as the letter of the drive is 
an important part of the file path! Please do not use spaces in the file path names. 
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The current files being installed will overwrite any that may already exist. If there is no 
directory on your computer with the name TOPSIM, then the installation program 
automatically creates a folder. The new management game is saved in the folder under a 
standard name. You may rename it afterwards if you wish. 
 
Note: The installation program also installs a special font for the reports. (Linedraw. ttf (and 
Linedraw.fot) in \Windows\Fonts or \Windows\System; entry in WIN.INI). Therefore, please 
restart Windows if you are using an old operating system in order to make these fonts ready 
for use. 
 
To exchange data between the instructor’s system and the participants’ systems, the 
participants’ systems’ file paths are entered in the Instructor’s system. This is carried out on 
your own system (the Instructor’s system). The procedure explaining how to do so is in the 
section called Data Transfer (4.4.4). 
 
Write access: 
Instructor:  Instructor’s System: Full access to the whole directory and subdirectories 
 Participants’ Systems: Full access to the whole directory and subdirectories 
 
Participants: Participants’ Systems: Each team operating a system has full access to it’s 

own directory and subdirectories 
 
 
The users can train themselves with their participant’s system and can study the initial 
situation of their company. 
 
The contents of the participant’s manual (pocket 1 in the binder) are included in the virtual 
visit of the company, allowing the participants to prepare for the seminar, with the use of the 
participant ‘s system alone. In preparation, participants do not require any diskettes. If the 
simulation is installed on a network, you must have already completed the initialization for the 
Participant’s system (see section 4.4.4). Studying the manual is more extensive than simply 
using the program to familiarize yourself with the company and the simulation. Therefore we 
recommend, by all means, studying the manual. 
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4. Operating Instructions: Overview 

4.1 Menus in the Instructor’s System 

4.1.1 The Base Menu of the Instructor’s System 

When you open the management game you will see the base menu. 
 

 
 

4.1.2 The Functions of the Individual Menus 

Here you are offered the functions for 
initializing a new game or restarting a 
game, managing existing game 
versions, exiting the program, and 
setting up your printer. The 
explanations of these functions can be 
found in the explanatory notes of the 
manual. 
 
 
 
With the Edit menu, you can enter the 
decisions of the participants or 
subsequently modify them, view the 
data that provides the framework for 
the entire simulation, or change the 

date of the reports to the current date in the course of the simulation. 
 

Simulation: 
Here you are able to simulate the 
next period once all of the decisions 
have been submitted, or repeat the 
last period (e.g. in order to 
accommodate modifications in 
parameters or decisions). You can 

also call up the planning models for the following periods, if you, as the instructor, wish to give 
the participating teams the opportunity to use it, if the groups are not operating their own 
users’ systems. However, in Period 0 the planning models are not yet available according to 
the default settings of the program.  Planning Model 1: Pre-simulation based on estimated 
volumes of sales; Planning Model 2: Market analysis based on assumptions about 
competitors; Planning Model 3: Break-even analysis for Product 2. 
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Here you can find your Instructor’s Reports, the 
Participants’ Reports, as well as the Analyses 
Reports, which you may structure in your own 
way, and which you can either display on the 

screen or print out. 
 
 
Data Transfer Offers a dialog box with functions for exchanging 

data with the participants’ system. 
 
 

Generates interfaces for graphics programs or 
graphically displays results directly on the screen. 
It is especially useful for portfolio analysis for the 
whole industry and for individual companies. 
 

 

4.2 The Information Line 

The information line is found at the bottom of the screen. The first field shows the name and 
the date of the seminar, (in this example: Seminar: DEMODATEN). In the next field, the 
period that was last calculated is shown, (in this example: Period 7). 
 

 
 
In the last field, actions are displayed (during the simulation for example) as report files are 
being generated, and as files are being transferred to and from the participants’ diskettes. If 
your computer is very fast, it may be that you do not even perceive that the system is in the 
process of performing a simulation. 
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5. General Operating Instructions 

You are offered functions via menus such as pop up menus and dialog boxes. For entering 
data such as decisions, the program offers you clearly laid out input forms. The results are 
provided in report or chart form. 

5.1 Entry Forms for the Input of Decisions 

There is an input field reserved for every value (e.g. the price of a product). The 
starting position of the cursor is the input field in the top left-hand corner. Confirm 

your entries by pressing the tab key. The cursor then moves automatically to the next input 
field. You may, of course, use the mouse to select the input fields as well. 
 
Check marks can be placed in check boxes by clicking on them or by using the space bar. 
 

Select the periods and companies via the scroll buttons at the top of the input forms. 
 

If you make an entry, which does not correspond to the required data format (e.g. letters 
instead of numbers), you will see an error message. The input field then automatically defaults 
to the last value entered in the field that corresponded to the correct format. 
 
Tip: If you make an entry in the wrong field by mistake, yet have not confirmed the entry 
by pressing the return key, simply enter an invalid character (e.g. letters if numbers are 
required). The system then displays an error message (see above), and restores the original 
value. 
 
Important: OK confirms your entries. Cancel rejects them. If you close the window, this is 
interpreted as canceling you entries. 

5.2 Simulation  

After you have completed your decision entries simply press the simulation button or 
select Simulate Next Period via the Simulation menu. You can also choose to repeat 

the simulation of a previous period from the same menu. Once the simulation has been 
completed you can view the results immediately, or pass them directly on to the participants.  
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5.3 Editing of Results  

     
 

The results can be 
displayed in chart or 
report format (similar to 
how accounting and 
finance departments in 
companies may present 
them). 
The report menu allows 
you to display or print 
out individual reports, a 
group of reports, or all of 
the reports. Here, the 
menu for the instructor’s 
reports is  shown 

5.3.4 On-Screen Display 

The first of the selected reports is displayed on the screen. You may go back and forth from 
one report to the next by using the buttons labeled Next and Previous.  
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5.3.4 Printing Reports 

You can select the reports to be printed from the reports menu. However, you can also print 
out the report that you are currently viewing on the screen, (see above).  
 

5.3.4 Printer Setup 

Ensure that the printer has been setup correctly before attempting to print.  
 
When the management game is opened, it automatically uses the same printer settings as 
those specified in the control panel (Windows 95/98/NT/2000/XP: Start menu, Settings, 
Control Panel). You can adapt them to your own requirements in the management game via 
the File menu, Printer Setup command. If you wish to change the printer settings for the 
course of the whole game, you are advised to do so via control panel. 
 
Recommendations for settings: 
• Portrait 
• Raster graphics / B/W or other suitable graphics; generally the setting which has the 

smallest storage requirement for the printer 
• With HP LaserJet-Printers: Under options select Print true type as graphics (this is of 

particular importance for HP LaserJet III printers). 
• Resolution: max. 300 dpi.  

Advantages: You can read the results better, you save time when printing, and you avoid 
problems with lines that may appear when you use a higher resolution. 
 

Note: The report menus can be closed only after printing jobs have been completely 
transferred to the system. This transfer takes place in seconds with newer computers. With 
older computers, it may take longer. In order to shorten this waiting period, using the print 
queue manager is recommended.  Also, keep sufficient storage space free on the hard drive 
for the temporary storage of files to be printed by the system. 
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5.3.4 Data Transfer 

 

 
 
The transfer of data between the instructor’s system and the participants’ systems is carried 
out via the Data Transfer menu.  
 
The Adjust Data Directories command is only active when the instructor’s system has been 
started as a network version, (see above). You will find details on Data Transfer in the notes. 

5.3.5 Analyses 

 
 
Using the Analyses menu, you can import graphics to presentation programs or view charts 
directly on the screen from the management game program. 
You will find more details about this in the appendix of explanatory notes. 
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6. Introductory Exercise 

If you have already installed and opened the management game, you will first see the main 
menu. 
 
Note: After installation, the management game is pre-set and can be started immediately. It is 
intended to be played by five groups of participants. The starting position (Period 0) has been 
simulated and the results are available to all of the groups (via participants’ and instructor’s 
reports). The information line states “Period O” in the second field.  
 
Decisions are also pre-set for all groups and for all periods: In all of the periods, all of the 
groups have the same decisions as Group 1 in Period 0. The parameters for the scenarios, 
and data on the economic conditions have already been entered for all the periods.  
 
Due to these pre-set values you can simulate one period after another because all of the data 
necessary for the calculations is available. However, each group's results in the individual 
periods will be the same because they are based on the same decisions for all groups in the 
various periods. The results vary from period to period only due to varying data on the state of 
the economy. 
 
Try this for Period 1: Click on Simulation from the main menu and then select the sub-menu 
item 
1  Simulate Next (1) Period 
 
The sub-menu also allows you to repeat Period 0. However, for this exercise please select 1 
Simulate Next (1) Period. The program then simulates Period 1. In other words, the results 
from Period 1 are simulated based on the available data. 
 
When the simulation of the period is complete, you will see the “Period 1” stated in the 
second field of the information line. 
 
Now select Reports from the main menu and Instructor’s Reports from the submenu. 
 

You will see the menu of the 
instructor’s reports. Now select 
the first report "Market Results," 
which you will then have 
displayed on your screen. 
 
 
 
 
 
 
 

The report shows the results for all groups in tabular form. Due to the decisions being the 
same for all groups, the results are also the same for all groups. Nevertheless, you should 
compare these values with those of Period 0 (see the printout in the users' manual). You will 
notice minor changes. These can be attributed to the fact that the economic data is slightly 
different for Period 1. 
 
Now you can close the report via the Back button and simulate a period: 
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Decision Entry: So that you may precisely see the effects of making a decision, we 
advise you to enter (i.e. change) one decision for just one group. Click on Edit in the 

main menu and Enter Decisions in the sub-menu, or click directly on the appropriate 
toolbar button. 
 

 
 
 
You will see the three tabs for decision input. (The first form is still a bit bare because at the 
beginning of the simulation only Product 1 and Market 1 are activated.) Company 1 and 
Period 1, which were last simulated, are preset. 
 
You will see the decision form. The cursor is positioned in the first input field (for the price of 
Product 1 on Market 1). Replace the given price with a new one. Now quit the decision form 
by pressing OK.  
 
Now select Simulation in the main menu and simulate Period 1 again.  
Here you see that you can always re-simulate a recently simulated period with altered 
data.  
 
If you now reselect the Market Report from the Instructor’s Reports menu, you can 
immediately see the effects of your decision for Group 1 and for the other groups as well. Via 
the Reports menu you can also view the participants’ reports for the individual groups. You 
may, of course, print out all of the reports.  
 
Normally you only need the following functions in a seminar: 
 
 Enter Decision Data, 
 Simulation, 
 Instructor’s Reports, 
 Participants’ Reports. 
 
If the participants are working with the participants’ software, you do not need to enter their 
decisions since you can read them from diskettes or via the network. ÖData Transfer. The 
procedure is explained in the section containing the explanatory notes. 
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7. List of Functions for TOPSIM - General Management II (Windows) 

File  

 Initialize New Simulation 
 

Allows you to enter the seminar’s characteristics, set the 
period to 0, and simulate the starting situation at the start 
of the game 

 Restart Simulation in Progress Returns the game to Period 0 in order to extrapolate results 
again with changed data. 

 Save Simulation in Progress Saves the current position of a game in progress with all its 
decisions and results. 

 Copy Simulation in Progress   
onto Hard Disk 

Saves a special game with parameters that you have 
specified as a quickly loadable game version (to your own 
directory in the management game). For example, you 
can save a version in which 4 or 5 groups made good 
decisions. If you do not have enough groups in another 
seminar, then you can load this version and allow the 
saved decisions to compensate for missing groups while 
participants of the seminar play companies 1 and 2. 

 Read External Data Version  Reads saved data from external device to a game version 
directory on the hard disk. 

 Printer Setup Allows changes in the printer settings for the game in 
progress. Otherwise, settings should be changed via the 
control panel. 

 Change Language 
 

Enables set up for the appropriate language 

 Exit 
 

Ends the program 

Edit  

 Decisions  Allows you to enter, correct, or view the decisions for all 
periods and for all groups 

 Instructor’s Data  
 z Initial Situation Allows you to reconstruct a new starting situation. 
 z Data for the Periods Scenarios for the periods. 
 z Activation of Features  Allows you to put various features of the simulation into effect 

(complexity/reports/planning functions/Bankrupt button)  
 z Graphs of Functions Parameters for the simulation model. 
 z Factors / Cost Allocation Parameters for the simulation model. 
 z Define Variables for Analyses Enables variables for analyses reports and graphs to be 

selected. 
 Date of Reports Allows the date that will be printed on reports to be specified 

Simulation  

 Simulate Next (x) Period  Simulates next period. 

 Simulate Previous Period Repeats simulation of the last period previously simulated 

 Planning Model 1 Pre-simulation based on estimated volumes of sales Only 
valid for the coming period and presents the decisions of 
the period last simulated. 

 Planning Model 2 Market analysis based on assumptions about competitors 

 Planning Model 3 Break-even analysis for Product 2. 
Reports  

 Instructor’s Reports  

 Participants’ Reports  

 Analyses Reports Simulates results for all periods and for all companies 

Data Transfer Reads decisions from the participants’ systems. Transferring 
the new results (reports) to the participants’ systems. 

At the start of the game, initialization of the participants’ 
systems for the course of the game (also specifies the 
number of companies).  

Allows the file paths of the participants’ systems to be 
entered. 

Analyses Provides an interface for presentation programs or graphically 
displays results directly onto the screen, especially useful 
for a portfolio analysis of the whole industry, as well as for 
individual companies. 



TOPSIM - General Management II  
Instructor's Manual - Introduction and Installation Page 16 

8. Activation of Features 

The management game consists of various features. The Activation of Features menu 
allows you to specify the periods in which the various features of the simulation start to apply. 
However, the so-called "Base Scenario" involving Product 1 sold on Market 1 always 
applies. 
In the version that we provide, there are always three game versions (data versions) included. 
They vary according to when and if features are activated.  
 
 
 
Game Version A: 6-Period Scenarios (for shorter seminars): 
 

 
 
 
 
Game Version B: 8-Period Scenario (for longer seminars): 
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Game Version C : Base Scenario, 8-Period Scenario, the simplest setting: 
 

 
 
When starting a new game and selecting the game version, the settings specifying when 
features will become active are automatically loaded. You will find detailed explanations 
concerning the extended scenario in pocket 4 of the instructor’s manual containing notes on 
the planning game. 


